Rules and Regulations
Formatting and Filing Manual

Rhode Island Administrative Procedures Act

September 2016 (Adopted)
October 2016 (Revised)
January 2017 (Revised)
February 2017 (Revised)
May 2017 (Revised)
June 13, 2017 (Revised)
June 30, 2017 (Revised)
September 2017 (Revised)
August 14, 2018 (Revised)
November 29, 2018 (Revised)
1.1 Formatting .................................................................................................................. 4
   1.1.1 Guidelines to formatting your RICR document ....................................................... 4
   1.1.2 Do’s and Don’ts ........................................................................................................ 5
   1.1.3 Working with the RICR Template and Microsoft Word ........................................... 6
   1.1.4 Style a Table in Word ............................................................................................. 10
   1.1.5 Graphics .................................................................................................................. 10
   1.1.6 Definitions ................................................................................................................ 12
   1.1.7 Citations ................................................................................................................... 12
   1.1.8 Troubleshooting Formatting Problems .................................................................... 18
   1.1.9 RICR Classification System .................................................................................... 22
   1.1.10 RICR Code Structure ............................................................................................ 25
1.2 General Filing Information .......................................................................................... 29
1.3 Adoption Procedures ................................................................................................. 31
   1.3.1 Initial Data Entry and Documents Upload ................................................................. 31
   1.3.2 Generation of the Notice of Proposed Rulemaking & Submission for Promulgation ... 33
   1.3.3 Post Public Comment Period Data Update and Document Upload ......................... 34
   1.3.4 Agency Head Signature Applied ............................................................................... 36
1.4 Amendment Procedures ............................................................................................. 36
   1.4.1 Initial Data Entry and Documents Upload: ................................................................. 36
   1.4.2 Generation of the Notice of Proposed Rulemaking & Submission for Promulgation ... 38
   1.4.3 Post Public Comment Period Data update and Document Upload ............................ 39
   1.4.4 Agency Head Signature Applied ............................................................................... 41
1.5 Repeal Procedures ..................................................................................................... 42
   1.5.1 Initial Data Entry and Documents Upload: ................................................................. 42
   1.5.2 Generation of the Notice of Proposed Rulemaking & Submission for Promulgation ... 43
   1.5.3 Post Public Comment Period Data update and Document Upload ............................ 45
1.5.4 Agency Head Signature Applied ................................................................. 47

1.6 Emergency Rule Procedures (§ 42-35-2.10) ................................................. 47

1.6.1 Initial Data Entry and Documents Upload, Rules Coordinator Notification and Submission for Promulgation: ................................................................. 48

1.6.2 Agency Head & Governor Signatures Applied ............................................. 49

1.6.3 Submission for Emergency Extension ........................................................ 50

1.7 Reviewing Public Comments ..................................................................... 50

1.8 Technical Revision Procedures (§ 42-35-4(b)) ............................................. 51

1.9 Termination Procedures ........................................................................... 52

1.10 Requirements under the APA ................................................................. 52

1.10.1 Rulemaking Agenda Procedures (§ 42-35-5.1) ......................................... 52

1.10.2 Guidance Document Index Procedures (§ 42-35-2.12) ............................. 53

1.10.3 Declaratory Orders and Declaratory Order Index Procedures (§ 42-35-8) ... 54

1.10.4 Advance Notice of Proposed Rulemaking Procedures (ANPRM) (§ 42-35-2.5) ................................................................. 54

1.10.5 Petition for Promulgation of Rules (§ 42-35-6) ......................................... 58

1.10.6 Petition for Declaratory Order (§ 42-35-8) ............................................. 58

1.10.7 Conduct of Public Hearings (§ 42-35-2) ................................................... 58

1.11 Appendix 1: Examples of Styles in the RICR Template ......................... 60

1.12 Appendix 2: Regular Rulemaking Process ................................................. 61

1.13 Appendix 3: Direct Final Rulemaking Process .......................................... 62

1.14 Appendix 4: Emergency Rulemaking Process .......................................... 63

1.15 Appendix 5: Concise Explanatory Statement Template ............................ 64

1.16 Appendix 6: Sample Petition for Promulgation of Rules Regulation ......... 65

1.17 Appendix 7: Sample Petition for Declaratory Order Regulation ............... 67

1.18 Appendix 8: Sample Conduct of Public Hearings Regulation .................. 69

1.1 Formatting

1.1.1 Guidelines for formatting your RICR document

A. The standard font to use for rule documents is Arial size 12.

B. Use only the RICR-specific styles. After installing the RICR Template, you may see additional styles in the drop-down list of styles which Word has automatically generated. Those additional styles do not affect the documents you create; however, you may only use the RICR-specific styles.

C. Do not use the Design ribbon in Word to apply styles to your document. Use the Styles available in the Home ribbon.

D. For examples of what the text looks like when the various styles are applied, see Appendix 1: Examples of Styles in the RICR Template.

E. When you copy and paste text from an existing document into the RICR template, you can avoid introducing additional styles by selecting “Paste Special” from the “Edit” menu, and then select “Unformatted Text;” however, this option will also remove bold, italics and underlines.

F. It is not permitted for a user to apply bold, italics and/or underlines in the document for any reason except to track changes or, in the case of italics only, Latin/legal terms. Certain RICR Styles will apply Bold to text as part of the style but it may not be applied manually outside of the RICR Styles. Bold, italics, and underline may not be used for emphasis. It may be necessary to click on a selected RICR style twice to apply the changes when cutting and pasting into the template to remove any remaining formatting such as underlines, bold, etc.

G. Each paragraph in a rule should have its own appropriate number/letter for citation purposes (except for Definitions - see § 1.1.6 Definitions).

H. You can review all paragraph designations in your regulation by clicking “View” at the top of the document, then clicking "Outline". Using this feature to review your regulation helps avoid skipping over numbers or letters when assigning paragraph designations.

I. Whenever possible, convert images containing only text to a table in Word to make that information searchable.

J. If you are inserting an image into your regulation, be sure to add "Alt Text" to describe the image and where someone may find more information about the image. For instructions on how to add alt text, see § 1.1.5(D).
K. A table of contents (TOC) may optionally be included in submitted rules longer than 30 pages. Begin your document with the RICR caption, then add the TOC. A page break should follow the TOC. The first heading of the rule will begin at the top of the next page.

L. You may not use any headers or footers in your rule. No page numbers or footnotes should appear in your rules. Citations should be handled in the body of the document and should be formatted in accordance with § 1.1.7 Citations.

M. Contact the Administrative Records Office staff if you need help creating documents or with the Rhode Island Code of Regulations Filing Application.

1.1.2 Do's and Don'ts

A. Final rules files must be saved as a Word (.doc or .docx) file.

B. Be sure to apply RICR styles to all text.

C. Use track changes or strike-out and underline to indicate amendments in proposed rules and redline documents. Proposed adoptions should contain all text underlined.

D. Number rules manually. Turn off automatic numbering and bullets.

E. Insert a tab between the paragraph designation and the text of the heading or paragraph for proper alignment.

F. The RICR styles will automatically indent paragraphs to the appropriate place on the page. Do not use the space bar, tab key, or ruler to align paragraphs to the left or right. You must only press the tab key once for each paragraph as described above.

G. Do not insert an additional hard return after a heading or a paragraph as the template automatically inserts a line space when you start a new heading or paragraph.

H. Do not use enumerations within paragraphs.

1. Example of original text: The Dept. of State requires that all rules filers (1) read the regulatory manual; (2) comply with the requirements found therein; and (3) contact Administrative Records with any questions.

2. Instead, format this paragraph as follows:

   a. The Dept. of State requires that all rules filers:

      (1) read the regulatory manual;

      (2) comply with the requirements found therein; and
(3) contact Administrative Records with any questions.

I. You may insert hyperlinks within your rule. These links will work and display in the new application. You can link to other Parts in the Code, areas of the Code of Federal Regulations, forms or guidance documents published on your website, or incorporated materials, as appropriate.

1.1.3 Working with the RICR Template and Microsoft Word

A. Download the RICR Template

1. Download the RICR Template (RICR Template) from: http://sos.ri.gov/divisions/open-government/state/rules-and-regulations

2. Save the template on your local drive.

3. The RICR Template contains all RICR styles necessary to format your document correctly.

B. How to Display the Style Area in the Document Window

1. You can quickly verify which RICR style has been applied to each heading or paragraph by displaying the “style area pane” or “Navigation” pane to the left of your document.

2. In Office 2010 and later (except Outlook):

   a. Click File.

   b. Click Options.

   c. Click Advanced.
d. Change the “Style area width” to 1 inch and click OK at the bottom of the “Word Options” window.

e. You can change views at any time by clicking the “Draft View” icon in the “View” menu at the top of the screen.

C. Display Styles Window

1. Styles can also be applied from the “Styles” window. To display the Styles window:
   a. Click on the small arrow at the bottom right corner of the “Styles” block of the ribbon that displays when you select the “Home” tab.
   b. The “Styles” window will open to the right of your document.

D. Turning off Auto Numbers and Auto Bullets. You must turn off auto-numbers and auto-bullets as both need to be manually keyed in rules documents. In Office 2010 and later (except Outlook):

1. Click File.
2. Click Options.
3. Click Proofing.

4. Click AutoCorrect Options.

5. Select “AutoFormat As You Type”.

6. Deselect “Automatic bulleted lists” and “Automatic numbered lists”.

E. Pasting Rule Text into the RICR Template

1. Open your rules document.

2. Select all the text (Ctrl + A) and copy (Ctrl + C).

3. Close the document.

4. Navigate to the RICR Template saved on your local drive and open it.

5. Paste your text (Ctrl + V) into the new document.

6. Save As a .doc or .docx file with a new name.

7. You can now begin to type new text or copy and paste text from an existing document, and then apply the RICR Template styles.

F. Creating Proposed Rule Documents and Applying RICR Styles to the Text

1. Track Changes Method: To create a “Proposed Rule” document, you can use the Track Changes feature in Word.
   a. Track Changes can be found on the “Review” tab ribbon. Select it to turn it on.
   b. After completing the changes save your document as a .doc or a .docx file.

2. Manual Method: Some agencies prefer not to use Track Changes and to manually create a Proposed Rule document. Underline should be used to indicate newly added language and strikeout should be used to indicate removed language. To manually strikeout text:
   a. Select the text and then click on the bottom right corner of the “Font” block of the “Home” tab ribbon.
   b. When the window opens, click the “Strikethrough” check-box and close the window.

G. Creating Final Rules Documents and Applying RICR Styles to the Text
1. Track Changes Method:
   a. Accept the changes and review the document to make sure all the changes appear correctly. To accept the changes, go to the "Review" tab in Word and press "Accept" for each change. If you know you want to accept all changes in the document, select "Accept All Changes and Stop Tracking" from the drop-down menu.
   b. Save your document as a Word (.doc or .docx) file.

2. Manual Method:
   a. Use the “Replace” feature found on the “Home” tab ribbon to remove stricken language.
   b. After opening the Replace window, place your cursor in the “Find what” field, select the “More” button and then select “Format” and “Font”.
   c. When the “Font” window opens, select “Strikethrough” and click “OK”.
   d. Complete the process by selecting “Replace All” and close the window.
   e. All stricken text should now be removed.
   f. To change the underlined text to normal font, select all text (Ctrl + A), then click the underline button twice. The underline button can be found in the Font block of the Home tab: ÷. You can also use the shortcut key Ctrl + U to perform this function.
   g. All the text should now be changed to normal font.
   h. Review and proof your document for accuracy and save the file as a .doc or .docx file.

H. Applying Styles to Text
   1. Styles can be applied by displaying the Styles Window to the right of your document.
   2. To apply styles, use one of the following two methods:
      a. Select a style and insert new text.
         (1) Choose the style you would like to use.
(2) Type your text or insert Unformatted Text or Formatted Text (RTF) from another document using “Paste Special”.

(3) The style chosen applies to all text inserted from that point forward.

(4) REMEMBER: Pasting as “Unformatted Text” will remove all bold, italics and underlines.

b. Apply a style to existing text.

(1) Click anywhere in a paragraph or heading, or highlight (select) the text to be styled.

(2) Click on the style you would like to apply.

(3) The style chosen applies to all text in the paragraph or heading up to the point of the first hard return, or all highlighted or selected text, which allows you to select more than one paragraph.

(4) REMEMBER: No matter what heading the text of the rule falls under, whether the text is under a heading 1.1 or a heading 4.1, always start the text of the rule using the ‘RICR Paragraph 1’ style.

I. Numbered Paragraphs

1. For numbered paragraphs:

a. Select the RICR Paragraph style you would like to use, depending on the level of the paragraph.

b. You will need to manually number paragraphs. Type the paragraph number, then insert a tab.

c. Type or insert the text of the paragraph.

1.1.4 Style a Table in Word

Create tables using Word’s Table feature found on the “Insert” tab. If possible, avoid using partial borders. You can use borderless cells and shading in your tables. All tables should use the RICR Text style.

1.1.5 Graphics

A. When filing documents with the Department of State you may leave maps and figures embedded in your rules documents.
B. Graphics and large tables can be presented in landscape view, for better appearance and usability.

C. Figures, graphics, and tables should be treated as paragraphs and subparagraphs using the appropriate RICR styles. The title of the figure, graphic, or table should be styled at the appropriate level. The actual figure, graphic, or table should be styled as if it were text below the paragraph-level style. Always make sure the figure, graphic or table is set to “In Line With Text” formatting.

1. Example:
   a. Structural Shoreline Protection Standards for Coastal Greenways

D. When inserting an image into your rules document you should provide Alt Text for the image so it is accessible to those utilizing assistive technologies to access your rule. Inserting Alt Text for your image:

1. Right-click on the image and select “Picture”.
2. Click on the Alt Text tab.
3. Enter the Alt Text for that image.
   a. Alt Text example:
      
      (1) Carcinogenic Substances - Industrial/Commercial Algorithm for Carcinogens in Soil

      \[
      C = \left( \frac{RISK \times AT \times CF}{CPSo \times EF} \right) \times \left( \frac{BW_a}{ED \times IRS_a} \right)
      \]

      (2) Alt Text: Industrial/Commercial Algorithm for Carcinogens in Soil. For more information, contact [insert contact information where the full formula can be requested].
1.1.6 Definitions

A. Use the following guidelines for formatting definitions:

1. Place definitions towards the beginning of the regulation.
2. Arrange the words or terms in alphabetical order.
3. Capitalize the first letter of the first word in each definition. All subsequent words in each definition should be lowercase, unless those words are proper nouns.
4. Place the word or term being defined within quotation marks.
5. Immediately after the word or term being defined, insert the word “means.”
6. Avoid using dashes, slashes or parentheses in a term being defined. For example, use “Individualized education plan” or “IEP” means... instead of “Individualized education plan (IEP)” means....
7. Definitions are not required to have individual paragraph letters UNLESS the Definitions section uses more than one RICR Paragraph level. If your Definitions section begins with an introductory clause (e.g., “For the purposes of this regulation, the following terms are defined as follows:"), you must use paragraph designations in the entire section.

1.1.7 Citations

A. The purpose of this section is to provide a uniform system of citation to agencies when revising/reformatting their regulations through the APA recodification process.

B. What is outlined below is a uniform citation which takes into account:

1. ease for the non-lawyer reader;
2. ease for the non-lawyer agency drafter;
3. ease for the out-of-state reader;
4. how other states cite to materials in their regulations; and
5. the requirements of the Rhode Island APA.

C. INCORPORATION BY REFERENCE VERSUS CITATION

1. Before you can cite to the material, you need to identify what type of material you are citing and whether you are incorporating it by reference.
a. INCORPORATION BY REFERENCE

(1) Federal Regulations

(AA) The Rhode Island APA allows agencies to incorporate federal regulations by reference. This includes materials properly incorporated by reference in federal regulations. Incorporation by reference is a drafting tool which allows agencies to give legal effect to federal regulations to allow for state level enforcement without publishing the regulation in full.

(2) Scientific/Technical Materials

(AA) The Rhode Island APA also allows agencies to incorporate "published codes, standards or guidelines of any nationally recognized scientific or technical association or organization" which is "regularly in the business of developing scientific or technical standards or guidelines, is recognized by those in the relevant professional community as having a high degree of expertise and competence in its field, and whose publications are widely distributed and easily available throughout the nation and the state of Rhode Island."

(BB) This is a drafting tool which allows an agency to give a code, standard or guideline of such an organization full legal effect (full force of law) so that the agency can then enforce compliance with that code, standard or guideline.

(3) Note: You cannot cite or incorporate guidance documents, agency policy or agency guidelines.

b. CITATIONS

(1) State and federal statutes already have the force of law behind them and therefore you need not “incorporate” them formally, you can simply reference them. State of Rhode Island regulations that have been properly promulgated are analogous to state statutes in that they already have the force of law behind them on a statewide level. As such, they can be referenced without formally “incorporating” them into the regulation. This is a particularly helpful tool to avoid conflicting regulations.

c. Quick Reference Guide:
(1) You can only incorporate by reference:

(AA) Federal regulations;

(BB) Materials properly incorporated in federal regulation; or

(CC) Codes, standards or guidelines published by nationally recognized scientific or technical organizations

(2) You can only cite to the following sources without formally incorporating them by reference:

(AA) Rhode Island statute;

(BB) Rhode Island regulation (which has already been properly promulgated); or

(CC) Any federal statute.

D. HOW TO CITE MATERIALS

1. HOW TO CITE TO A FEDERAL STATUTE

a. Full Citation:


b. Short Citation:


2. HOW TO CITE TO A RHODE ISLAND STATUTE
a. Note: You can find the “Section” symbol (§) in Word under “Insert” > “Symbol” > “Special Characters”. You can create a shortcut key to quickly access the § symbol if you will be using it frequently.

3. HOW TO CITE TO A RHODE ISLAND REGULATION

a. When citing to a different Title:

b. Citing within the same Part

(1) Citing to a Section within a Part: § 7.2 of this Part.

(2) Citing to a Subsection within a Part: § 7.2(A) of this Part.

c. Citing within the same Subchapter

(1) Citing to a Part within the same Subchapter: Part 7 of this Subchapter.

(2) Citing to a Section within the same Subchapter: § 7.2 of this Subchapter.

(3) Citing to a Subsection within the same Subchapter: § 7.2(A) of this Subchapter.
d. Citing within the same Chapter:

(1) Citing to a Subchapter within the same Chapter: Subchapter 15 of this Chapter.

(2) Citing to a Part within the same Chapter: Subchapter 15 Part 7 of this Chapter.

(3) Citing to a Section or Subsection within the same Chapter: § 15-7.2(A) of this Chapter.

e. Citing within the same Title

(1) Citing to a Chapter within the same Title: Chapter 20 of this Title.

(2) Citing to a Subchapter within the same Title: Subchapter 20-15 of this Title.

(3) Citing to a Part within the same Title: Part 20-15-7 of this Title.

(4) Citing to a Section or Subsection within the same Title: § 20-15-7.2(A) of this Title.

f. Note: If you are citing a rule that has not been filed in the RICR, use the title of the rule enclosed by quotation marks (e.g. “Department of Health Rules and Regulations Regarding Health Care Workers”). Once the rule is filed in the RICR, the citation can be changed via technical revision.

E. HOW TO INCORPORATE A MATERIAL BY REFERENCE

1. Step by Step Guide for Incorporation by Reference

a. Step One: Create an “Incorporated Materials” Section. We recommend that this come between the “Authority” and “Definition” sections of the regulation.

b. Step Two: Create a subsection for each material you wish to incorporate by reference.

c. Step Three: Add language “These regulations hereby adopt and incorporate [insert citation] by reference, not including any further editions or amendments thereof and only to the extent that the provisions therein are not inconsistent with these regulations.”
d. Step Four: Insert citation in the format described in §§ 1.1.7(F) through (G) below.

e. Note: If the material is not considered a federal regulation, a material properly incorporated by reference in a federal regulation or a scientific/technical material, it cannot be incorporated by reference.

2. EXAMPLE OF INCORPORATED BY REFERENCE SECTION WITH CORRECT CITATIONS

### 3.3 Incorporated Materials

A. These regulations hereby adopt and incorporate 16 C.F.R. § 444.1 (2014) by reference, not including any further editions or amendments thereof and only to the extent that the provisions therein are not inconsistent with these regulations.

B. These regulations hereby adopt and incorporate the American Medical Association’s “Standards for Taking Blood Samples” (2001) by reference, not including any further editions or amendments thereof and only to the extent that the provisions therein are not inconsistent with these regulations.

C. These regulations hereby adopt and incorporate the “National Geological Society Guidelines for the Safe Gemstone Excavation” (2015) by reference, not including any further editions or amendments thereof and only to the extent that the provisions herein are not inconsistent with these regulations.

a. Note: You can cite to the incorporated material in the body of your regulation by referencing the Incorporated Materials subsection.

b. Examples:

   (1) Phlebotomists must maintain their syringes in the manner prescribed in “Standards for taking Blood Samples”, incorporated above at § 3.3(B) of this Part.

   (2) Geologists must mine for diamonds in accordance with “National Geological Society Guidelines for the Safe Gemstone Excavation”, incorporated above at § 3.3(B) of this Part.

F. CREATING CITATION FOR INCORPORATION OF FEDERAL REGULATIONS BY REFERENCE
1. Give the name of the regulation only if the regulation is commonly cited that way:


a. Note: You can include hyperlinks to federal regulations within your rule document.

b. Note: You should be incorporating the most recent version of the C.F.R. If you have previously referenced a C.F.R. from a prior year, changing the year will be a substantive change that should be marked by track changes.

c. Note: The year is required for all materials incorporated by reference.

G. CREATING CITATION FOR INCORPORATION OF SCIENTIFIC/TECHNICAL MATERIALS BY REFERENCE

1. The Rhode Island APA requires that the reference include the name of the association or organization, the title of the material and the date of the material. You may also include a link to the material, if applicable.

1.1.8 Troubleshooting Formatting Problems

A. Occasionally, when you open a document, the text may appear to have lost the styles you have applied. If that happens, try Copying and Pasting into a new Template Document:

1. Select all the text (ctrl + A) and copy it (Ctrl + C).

2. Close the document.
3. Navigate to the RICR Template saved on your local drive and open it.

4. Paste your text (Ctrl + V) into the new document.

5. Save As a .doc or .docx file with a new name.

B. Turning off style restrictions in the RICR Template

1. Pop the Style Window out to anchor on the right side of your document by clicking on the small box at the bottom right of the Style ribbon.

2. Click on Manage Styles button.

3. Click -> Restrict tab and unclick the Limit formatting to permitted styles check box -> click OK.
4. You can always turn the restriction back on following the same steps and clicking Limit formatting to permitted styles>OK. When you turn the Restriction back on you will receive a pop-up box. You do not need to enter a password. Just click OK.

C. Importing RICR Styles into any Word document

1. Open the document you want to import style to in Word then click File>Options>Custom Ribbon to add the Developer under the Main Tabs to ribbon.
2. Click Document Template under the Developer Tab. In the popup dialog box, click Organizer.

3. There will be another popup dialog box. Click Close File on the right.
4. Click Open File and select RICR-Template.dotx (you may have to change the file type to "All Files"), then click Open.

5. After opening RICR-Template.dotx, you can select the RICR styles in the right box and click Copy. This will copy the style to the left box.

6. After copying the styles to the left box, click Close. The style importing is finished.

1.1.9 RICR Classification System

A. The Rhode Island Code of Regulations (RICR) is a classification system that orders regulations by agency. Each agency is then organized into chapters, subchapters, and parts.

B. The RICR has four (4) major divisions:
1. Title: Agency name.

2. Chapter: A core function of the agency. Some smaller agencies may not need to give a name to this level, but it is required and will be labeled “00” if a name is not supplied by the agency.

3. Subchapter: Topic area within a core function of the agency. Larger agencies may need to name these additional levels; it is required and will be labeled “00” if a name is not supplied by the agency.


<table>
<thead>
<tr>
<th>Title (Agency)</th>
<th>Code</th>
<th>Chapter (Function)</th>
<th>Subchapter (Topic)</th>
<th>Part (Rule)</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>RICR</td>
<td>10</td>
<td>05</td>
<td>1</td>
<td>.1(A)(1)(a)((1))</td>
</tr>
</tbody>
</table>

Citation: 100-RICR-10-05-1.1(A)(1)(a)((1))

### EXAMPLES

<table>
<thead>
<tr>
<th>TITLE</th>
<th>CODE</th>
<th>CHAPTER</th>
<th>SUBCHAPTER</th>
<th>PART</th>
<th>SECTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>250-</td>
<td>RICR-</td>
<td>40-</td>
<td>05-</td>
<td>4</td>
<td>.8 Species Specific Standards</td>
</tr>
<tr>
<td>Dept. of Environmental</td>
<td></td>
<td>Agriculture and Resource</td>
<td>Animal Health</td>
<td>Animal Care</td>
<td></td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td>Marketing</td>
<td></td>
<td>Facilities</td>
<td></td>
</tr>
<tr>
<td>216-</td>
<td>RICR-</td>
<td>50-</td>
<td>10-</td>
<td>6</td>
<td>.3.1 License for a Shellfish Business</td>
</tr>
<tr>
<td>Dept. of Health</td>
<td></td>
<td>Environmental Health</td>
<td>Food Protection</td>
<td>Processing</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>and Distribution</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>of Shellfish</td>
<td></td>
</tr>
<tr>
<td>230-</td>
<td>RICR-</td>
<td>30-</td>
<td>20-</td>
<td>2</td>
<td>.2(A)(3) “Clock hour” definition</td>
</tr>
<tr>
<td>Dept. of Business Regulation</td>
<td></td>
<td>Commercial Licensing</td>
<td>Real Estate</td>
<td>Real Estate</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Brokers and</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Salespersons</td>
<td></td>
</tr>
<tr>
<td>C. Title</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
This classification level represents state agencies. These include general officers, executive branch agencies, boards and commissions, and quasi-public agencies with specific rulemaking authority granted by R.I. Gen. Laws. The numbering scheme begins with 100 and increases by multiples of 2, 5 or 10 based on the entity type and its relationship to other entities in the Code. The three-digit indicator allows for growth over time, including the placement of new agencies near related agencies in the code (e.g. EOHHS is 210, with sub-agencies represented by 212, 214, etc.).

D. Rhode Island Code of Regulations (RICR)

The four-letter code "RICR" indicates a rule published in the official Rhode Island Code of Regulations.

E. Chapter

This classification level represents major agency functions. Agencies will distinguish between functions by assigning chapter numbers using a skip 10 method (e.g. 10, 20, 30...110, etc.). The skip method allows room to insert new functions near related functions in the future. Agencies may use “00” if there is no need to differentiate a topic.

F. Subchapter

Agencies can use this level to organize functions by topic area if necessary. Agencies will assign subchapter numbers using a skip 5 method (e.g. 05, 10, 15). Agencies may use “00” if there is no need to differentiate a topic.

G. Part

A Part represents an individual rule regulating a specific topic. Parts are assigned using a skip 1 method (e.g. 1, 2, 3, 4).

H. Section Levels

1. A section represents the individual headings that make up a Part. Sections are divided into six levels:
   a. RICR Heading 1 - (ex. .1, .2, .3, .4, etc.)
   b. RICR Subheading/Subchapter (ex. .1.1, .1.2, .1.3, .1.4, etc.)
   c. RICR Par 1 - (ex. A., B., C., D., etc.);
   d. RICR Par 2 - (ex. 1., 2., 3., 4., etc.);
   e. RICR Par 3 - (ex. a., b., c., d., etc.); and
   f. RICR Par 4 - (ex. (1), (2), (3), (4), etc.).
2. Note: Agencies should make every attempt to limit the number of subsection levels to no more than six levels to reduce regulatory volume while maintaining readability. In the rare cases where additional levels are required, there are two additional levels available to handle these exceptions. The additional two levels are:

a. RICR Par 5 (ex. (AA), (BB), (CC), (DD), etc.).

b. RICR Par 6 (ex. (i), (ii), (iii), (iv), etc.)

c. There are no additional levels beyond RICR Paragraph 6.

I. Additional Rules Surrounding Code Design

1. Decimal points are not allowed at the Title, Chapter, Subchapter or Part level.

2. Parts cannot be renumbered to accommodate repealed regulations.

1.1.10 RICR Code Structure

All questions related to Title designations should be directed to the Department of State’s Administrative Records Office.

<table>
<thead>
<tr>
<th>Title Number</th>
<th>Agency</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Department of State</td>
</tr>
<tr>
<td>110</td>
<td>Attorney General</td>
</tr>
<tr>
<td>120</td>
<td>Treasury Department</td>
</tr>
<tr>
<td>130</td>
<td>Auditor General</td>
</tr>
<tr>
<td>152</td>
<td>Unauthorized Practice of Law Committee</td>
</tr>
<tr>
<td>160</td>
<td>Permanent Joint Committee on Legislative Services</td>
</tr>
<tr>
<td>170</td>
<td>Executive Office of Commerce</td>
</tr>
<tr>
<td>180</td>
<td>The Office of Veterans Affairs</td>
</tr>
<tr>
<td>200</td>
<td>Board of Education</td>
</tr>
<tr>
<td>Code</td>
<td>Department Name</td>
</tr>
<tr>
<td>------</td>
<td>----------------</td>
</tr>
<tr>
<td>210</td>
<td>Executive Office of Health and Human Services</td>
</tr>
<tr>
<td>212</td>
<td>Department of Behavioral Healthcare, Developmental Disabilities and Hospitals</td>
</tr>
<tr>
<td>214</td>
<td>Department of Children, Youth, and Families</td>
</tr>
<tr>
<td>216</td>
<td>Department of Health</td>
</tr>
<tr>
<td>218</td>
<td>Department of Human Services</td>
</tr>
<tr>
<td>220</td>
<td>Department of Administration</td>
</tr>
<tr>
<td>230</td>
<td>Department of Business Regulation</td>
</tr>
<tr>
<td>232</td>
<td>Office of the Health Insurance Commissioner</td>
</tr>
<tr>
<td>240</td>
<td>Department of Corrections</td>
</tr>
<tr>
<td>242</td>
<td>Parole Board</td>
</tr>
<tr>
<td>244</td>
<td>Batterer’s Intervention Program Standards Oversight Committee</td>
</tr>
<tr>
<td>250</td>
<td>Department of Environmental Management</td>
</tr>
<tr>
<td>260</td>
<td>Department of Labor and Training</td>
</tr>
<tr>
<td>270</td>
<td>Department of Public Safety</td>
</tr>
<tr>
<td>280</td>
<td>Department of Revenue</td>
</tr>
<tr>
<td>290</td>
<td>Department of Transportation</td>
</tr>
<tr>
<td>300</td>
<td>Office of Energy Resources</td>
</tr>
<tr>
<td>400</td>
<td>Board of Accountancy</td>
</tr>
<tr>
<td>405</td>
<td>Board of Certification of Operators of Wastewater Treatment Facilities</td>
</tr>
<tr>
<td>410</td>
<td>Board of Elections</td>
</tr>
<tr>
<td></td>
<td>Board of Examination and Registration of Architects</td>
</tr>
<tr>
<td>---</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>420</td>
<td>Board of Examiners of Professional Landscape Architects</td>
</tr>
<tr>
<td>425</td>
<td>Board of Medical Licensure and Discipline</td>
</tr>
<tr>
<td>430</td>
<td>Board of Registration for Professional Engineers</td>
</tr>
<tr>
<td>435</td>
<td>Board of Registration for Professional Land Surveyors</td>
</tr>
<tr>
<td>440</td>
<td>Contractors’ Registration &amp; Licensing Board</td>
</tr>
<tr>
<td>445</td>
<td>Energy Facility Siting Board</td>
</tr>
<tr>
<td>450</td>
<td>Fire Safety Code Board of Appeal and Review</td>
</tr>
<tr>
<td>455</td>
<td>Governor's Workforce Board (formerly known as Human Resource Investment Council)</td>
</tr>
<tr>
<td>460</td>
<td>Labor and Training Board of Review</td>
</tr>
<tr>
<td>465</td>
<td>Labor Relations Board</td>
</tr>
<tr>
<td>470</td>
<td>Motor Vehicle Arbitration Board</td>
</tr>
<tr>
<td>475</td>
<td>Personnel Appeal Board</td>
</tr>
<tr>
<td>480</td>
<td>State Housing Appeals Board</td>
</tr>
<tr>
<td>490</td>
<td>Water Resources Board</td>
</tr>
<tr>
<td>500</td>
<td>Advisory Commission on Historical Cemeteries</td>
</tr>
<tr>
<td>505</td>
<td>Agricultural Lands Preservation Commission</td>
</tr>
<tr>
<td>510</td>
<td>Building Code Commission</td>
</tr>
<tr>
<td>515</td>
<td>Commission for Human Rights</td>
</tr>
<tr>
<td>No.</td>
<td>Commission</td>
</tr>
<tr>
<td>-----</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>520</td>
<td>Ethics Commission</td>
</tr>
<tr>
<td>525</td>
<td>Governor’s Commission on Disabilities</td>
</tr>
<tr>
<td>530</td>
<td>Historical Preservation &amp; Heritage Commission</td>
</tr>
<tr>
<td>545</td>
<td>Judicial Nominating Commission</td>
</tr>
<tr>
<td>550</td>
<td>State Traffic Commission</td>
</tr>
<tr>
<td>555</td>
<td>Vehicle Value Commission</td>
</tr>
<tr>
<td>600</td>
<td>State Properties Committee</td>
</tr>
<tr>
<td>650</td>
<td>Coastal Resources Management Council</td>
</tr>
<tr>
<td>660</td>
<td>Rivers Council</td>
</tr>
<tr>
<td>665</td>
<td>State Council on the Arts</td>
</tr>
<tr>
<td>670</td>
<td>State Planning Council</td>
</tr>
<tr>
<td>800</td>
<td>Airport Corporation</td>
</tr>
<tr>
<td>805</td>
<td>Capital Center Commission</td>
</tr>
<tr>
<td>810</td>
<td>Public Utilities Commission</td>
</tr>
<tr>
<td>815</td>
<td>Division of Public Utilities and Carriers</td>
</tr>
<tr>
<td>820</td>
<td>Health and Educational Building Corporation</td>
</tr>
<tr>
<td>825</td>
<td>Housing and Mortgage Finance Corporation</td>
</tr>
<tr>
<td>830</td>
<td>Infrastructure Bank</td>
</tr>
<tr>
<td>835</td>
<td>Narragansett Bay Commission</td>
</tr>
<tr>
<td>840</td>
<td>Public Transit Authority</td>
</tr>
</tbody>
</table>
1.2 General Filing Information

A. This section’s purpose is to guide agencies on the mechanics of filing rules and regulations with the Department of State using the RICR Filing Application.

B. For guidance on writing state regulations, please refer to the Office of Management and Budget Rhode Island Administrative Procedures Act Regulatory Manual and related documents, found at [www.omb.ri.gov/reform](http://www.omb.ri.gov/reform).

C. In the RICR Filing Application you will complete your public notice using the online form and, after review, will generate and publish the notice as a PDF to the RICR website.

1. The red asterisk (ex. Rulemaking Authority: *) next to a section of the form denotes a required field.

2. The ? signals a tool tip over which you can hover with your cursor to provide helpful explanations for fields and terms used in the application.

D. The legend for the icons used in the RICR application is as follows:
E. The steps of the normal rulemaking process are as follows:

1. Initial Data Entry and Documents Upload
2. DOS Verification of Drafts
3. Generation of the Notice of Proposed Rulemaking
4. Submission for Promulgation (system generated)
5. Public Comment Period Begin
6. Post Public Comment Period Data update and Document Upload
7. DOS Final Regulation Approval
8. Agency Head Signature Applied
9. Final Rule and Signature acceptance by DOS
10. Promulgation Finalization (system generated)
F. When filing regulations, we strongly recommend using a browser other than Internet Explorer, such as Google Chrome.

1.3 Adoption Procedures

1.3.1 Initial Data Entry and Documents Upload

A. Go the RICR application login page at: https://rules.sos.ri.gov/login and provide your login credentials.

B. Make sure you have the “Current Rules” tab opened at the top of the screen. Click on: “+ [Title Name]” to expand listing to show all available Chapters.

C. Click on “+ [Chapter Name]” to expand listing to show all available Subchapters.

D. Click on the blue button for “New Adoption” next to “+ [Subchapter Name]”.
   1. Note: If your subchapter has not been given a name, you can still click the + symbol or the numbers 00 to expand the listing to show all effective Parts.

E. Click on the radio button to select “Proposed” for the Rulemaking Action.

F. Click on the appropriate radio button for the “Rulemaking Process: *”. Either select “Regular” or “Direct Final”.

G. Enter the Part number of your choice in the text field for “Rule Identifier: *” Note: This must be a new Part number not already in use for this Title-Chapter-Subchapter.

H. Enter the name of the regulation in the text field for the “Regulation Title: *”.

I. Select either “R.I. General Laws” or "Alternative" as the selection in the drop-down menu in “Rulemaking Authority: *” and enter the appropriate citation in the empty text box and then click on the blue “Add >>” button. You may do this action as many times as necessary to list all the applicable statutory authorities for your adoption.
   1. When "R.I. General Laws" is selected, you only need to put in the actual numbers of the citation (ex. 42-35-1). The application will build the rest of the citation for you.

J. In plain language, provide a statement of the subject matter of the proposed rule. You should include the terms or substance of the intended action or a description of the issues involved. Include a summary of any non-technical changes between current and proposed regulations in the “Summary of Proposed Rule: *” field by typing or by cutting and pasting from an existing document.
K. Provide a brief paragraph regarding the societal cost and benefits and cost of compliance as prepared under R.I. Gen. Laws § 42-35-2.9. Include any citations to scientific or statistical studies, reports, or analyses that served as a basis for the proposed rule in the “Regulatory Analysis Summary and Supporting Documentation: *” field by typing or by cutting and pasting from an existing document.

L. Enter the web address for the location on your website where the notice of proposed rulemaking and summary of the regulatory analysis are published in the “Additional Information URL: *” field.

M. Click the blue “Submit” button at the bottom of the page.

N. Click the blue “Upload Documents” button.

O. Select “Proposed Rule” from the “Document Type” drop-down menu.

P. Click on “Choose File” or “Browse” button (depending on your browser) and select the Word document containing the proposed rule with new language clearly marked using underline formatting.

Q. Click the blue “Upload Document” button. You can continue to upload additional documents, if you wish, by clicking "Upload More Documents."

R. Click the blue “Home” button.

S. You can now review the proposed rule you uploaded under the "Text" tab on the right side of the screen. You can use this feature to check your work and make sure the RICR styles from the template are correctly applied. This is also an easy way to check the numbering in your rule.

T. To submit for review by the Department of State (DOS): Under the “Work Queue” tab, click on the icon next to the title of the rule you just proposed to adopt to Advance Workflow. On the next page, click the green “Advance” button.

U. A notification will appear regarding the Office of Regulatory Reform’s review of this filing. If you have received ORR approval, click “Yes.”

V. Provide any necessary notes to the Department of State staff in text fields for “Outcome Note” and “Request Note” (optional).

W. Click the blue “Submit” button at the bottom of the screen.

X. Click “OK”. Your submission will be forwarded to the Department of State for formatting review. Please note the Department of State may take up to 5 business days to review and advance or reject your filing.
1.3.2 Generation of the Notice of Proposed Rulemaking & Submission for Promulgation

A. Under the “Work Queue” tab at the top of the screen, expand the Title>Chapter>Subchapter to view your proposed adoption and click on to generate the Notice of Proposed Rulemaking and publish your proposed adoption to the RICR website.

B. Click on the “Add>>” button under “Add a Public Comment Period.”

C. The Date of Public Notice will automatically be set to the date you generate the notice. Click on the text box below “Date of End of Comment Period” and select a valid date for the end of comment period. The application will automatically calculate 30 days from the date you generate the notice.

D. Enter the name of the person designated to receive comments for this filing in the “Full Name of Contact Person” text box.

E. Enter the email address of that individual in the “Contact Person Email” text box.

F. Enter the physical address where you would like the public to direct comments.

G. Click on the appropriate radio button to indicate whether you will be accepting online submission of public comments under “Allow online public comments?”
   1. If you select “Yes,” you will then indicate the dates during which you will accept comments through the RICR. These dates will automatically be pre-set to match the public comment period you indicated in your notice.
   2. If you select “No,” you are still required to accept public comments outside of the RICR.

H. Click “OK.”

I. If you will be having a Public Hearing, complete these additional steps:
   1. In the text box to the right of the first “Add >>” button, click on the dates for the public comment period you just entered.
   2. Click on the “Add >>” button under the “Add a Public Hearing” section.
   3. Click the text box under “Hearing date/time.” The application will automatically calculate all available dates ten days after the beginning of your comment period and five days before the end of that comment period. Select a hearing date.
   4. Click the dropdown box next to “Time:” and select a time and “AM” or “PM.”
5. Enter text into the fields under “Hearing Location:” marked “Address Line 1”, “City” and “Zip code.”

6. Enter the phone number for the Special Assistance contact in the “Phone Number for Special Assistance” text box. You are not required to enter an extension, but you may.

7. Click on “Ok.”

J. Click on the blue “Generate Notice” button at the bottom of the screen.

K. You will now be able to review the public notice you just created before publishing your rule. Review your notice. If you approve, click “Publish.” If you wish to make changes, press “Cancel” to return to the previous screen.

L. You will receive confirmation and a list of documents now available on the public-facing RICR application.

1.3.3 Post Public Comment Period Data Update and Document Upload

A. Under the “Work Queue” tab at the top of the screen, expand the Title>Chapter>Subchapter to view your proposed adoption. If you opted to accept public comments through the RICR during the public comment period, click the icon to review submitted public comments. You must review all public comments before advancing the workflow to the next step. For tips on reviewing public comments submitted through the RICR, see § 1.7 of this Manual.

B. Click on Upload Documents next to the proposed adoption that has completed the public comment period. Download the .doc or .docx version of the proposed rule last uploaded by Department of State staff. Use this version to accept the proposed changes and make additional edits to the rule. This will facilitate a more efficient review at the final step of the rulemaking process.

C. Click the drop-down menu under “Document Type:” and select “Final Rule” from the drop-down menu.

D. Click on “Choose File” or “Browse” (depending on your browser) and select the final, clean Word document for the proposed adoption (final text of the rule, no underlined or struck-through text) and click on the blue “Upload Document” button. (Required)

E. Click the blue “Upload More Documents” button and under “Document Type” select “Public Comment” from the drop-down menu.

F. Click “Choose File” or “Browse” (depending on your browser) and select the document containing a copy of all comments received – or a statement that no
comments were received - and click on the blue “Upload Document” button. You may upload additional Public Comment documents, if needed. (Required)

1. You do not need to upload copies of any comments received through the RICR as the application will file those on your behalf.

2. If you considered any comments received inappropriate for public display, those comments should still be kept with the rulemaking file transferred to the Department of State. If the comment was received through the RICR, this process is complete. If the comment was received by other means, you will need to submit a copy of the comment by email to Administrative Records staff by emailing rulesregs@sos.ri.gov.

G. Click the blue “Upload More Documents” button and under “Document Type” select “Concise Explanatory Statement” from the drop-down menu.

H. Click “Choose File” or “Browse” (depending on your browser) and select your concise explanatory statement. Click “Upload Document.” A template for this document can be found at § 1.15, Appendix 5. (Required)

I. If necessary, click the blue “Upload More Documents” button and under “Document Type” select the appropriate document type(s) from the drop-down menu:

1. Internal Agency Document (See R.I. Gen. Laws § 42-35-2.3(b)(9))
2. Public Hearing Documents (See R.I. Gen. Laws § 42-35-2.3(b)(5))
3. Studies/Reports (See R.I. Gen. Laws § 42-35-2.3(b)(3))
4. Index of Studies/Reports (See R.I. Gen. Laws § 42-35-2.3(b)(3))
5. Petition seeking agency action for this rule (See R.I. Gen. Laws § 42-35-2.3(B)(8))

J. Click the blue “Home” button.

K. To submit for review by the Department of State (DOS): Under the “Work Queue” tab, click on the green icon next to the title of the rule you just proposed to amend to Advance Workflow. On the next page, click the green “Advance” button.

L. A notification will appear regarding the Office of Regulatory Reform’s review of this filing. This applies to regular rulemaking only. If you have received ORR approval, click “Yes.”

M. Provide any necessary notes to the Department of State staff in the text fields for “Outcome Note” and “Request Note.”
1. Note: If this rule should become effective any later than the typical 20 days after filing, please leave a note for the Department of State in the "Request Note" field with the date you would like this regulation to be effective.

N. Click the blue “Submit” button at the bottom of the screen.

O. Click “OK”. Your submission will be forwarded to the Department of State for formatting review. Please note the Department of State may take up to 5 business days to review and advance or reject your filing.

1.3.4 Agency Head Signature Applied

A. Once the Department of State completes the format review and advances the workflow, an email notification will be sent to the designated Agency Head from eSignLive requesting his or her e-signature. The message will state, “The APA System has added you as a Signer to the eSignPackage “XXX-RICR-XX-XX-XX Title of Regulation”.

B. Once the Agency Head clicks the blue “Go to Documents” button in the eSignLive notification email, he or she will be directed to the secure e-signature site. The Agency Head must accept eSignLive’s consent and disclosures before clicking the marked box to affix his or her digital signature.

C. eSignLive will securely forward the digitally signed document to Department of State staff for final processing. Once the document is fully signed and processed, the Agency Head will receive email confirmation that the e-signing process has been completed.

1. The full e-signature procedures are laid out in the Guide for Agency Heads, a copy of which is included at § 1.18, Appendix 9.

1.4 Amendment Procedures

1.4.1 Initial Data Entry and Documents Upload:

A. Go the RICR application login page at: https://rules.sos.ri.gov/login and provide your login credentials.

B. Make sure you have the “Current Rules” tab opened at the top of the screen. Click on: “+ [Title Name]” to expand listing to show all available Chapters.

C. Click on “+ [Chapter Name]” to expand listing to show all available Subchapters.

D. Click on “+ [Subchapter Name]” to expand listing to show all available Parts.

E. Click on the 📂 icon next to the Part you wish to amend.

F. Click on the radio button to select “Proposed” for the Rulemaking Action.
G. Click on the appropriate radio button for the “Rulemaking Process: *”. Either select “Regular” or “Direct Final”.

H. Verify the name of the Part is correct in the field marked “Regulation Title: *”.

I. If you wish to change or amend the rulemaking authority for this Part, select either "R.I. General Laws" or "Alternative" as the selection in the drop-down menu in “Rulemaking Authority: *” and enter the appropriate citation in the empty text box and then click on the blue “Add >>” button. You may do this action as many times as necessary to list all the applicable statutory authorities for your adoption.

1. When "R.I. General Laws" is selected, you only need to put in the actual numbers of the citation (ex. 42-35-1). The application will build the rest of the citation for you.

J. The summary of proposed rule will be pre-populated from the last rulemaking action for this Part in the “Summary of Proposed Rule: *” field. You may alter this text as needed.

K. Provide a brief paragraph regarding the societal cost and benefits and cost of compliance as prepared under R.I. Gen. Laws § 42-35-2.9. Include any citations to scientific or statistical studies, reports, or analyses that served as a basis for the proposed rule in the “Regulatory Analysis Summary and Supporting Documentation: *” field by typing or by cutting and pasting from an existing document.

L. Enter the web address for the location on your website where the notice of proposed rulemaking and summary of the regulatory analysis are published in the “Additional Information URL: *” field.

M. Click the blue “Submit” button at the bottom of the page.

N. Click the blue “Upload Documents” button.

O. Select “Proposed Rule” from the “Document Type” drop-down menu.

P. Click on “Choose File” or “Browse” button (depending on your browser) and select the Word document containing the proposed rule with new language clearly marked using underline formatting and proposed deletions using strikethrough formatting.

Q. Click the blue “Upload Document” button. You can continue to upload additional documents, if you wish, by clicking “Upload More Documents.”

R. Click the blue “Home” button.
S. You can now review the proposed rule you uploaded under the "Text" tab on the right side of the screen. You can use this feature to check your work and make sure the RICR styles from the template are correctly applied. This is also an easy way to check the numbering in your rule.

T. To submit for review by the Department of State (DOS): Under the "Work Queue" tab, click on the icon next to the title of the rule you just proposed to amend to Advance Workflow. On the next page, click the green "Advance" button.

U. A notification will appear regarding the Office of Regulatory Reform’s review of this filing. If you have received ORR approval, click “Yes.”

V. Provide any necessary notes to the Department of State staff in text fields for “Outcome Note” and “Request Note” (optional).

W. Click the blue “Submit” button at the bottom of the screen.

X. Click “OK”. Your submission will be forwarded to the Department of State for formatting review. Please note the Department of State may take up to 5 business days to review and advance or reject your filing.

1.4.2 Generation of the Notice of Proposed Rulemaking & Submission for Promulgation

A. Under the “Work Queue” tab at the top of the screen, expand the Title>Chapter>Subchapter to view your proposed amendment and click on the icon to generate the Notice of Proposed Rulemaking and publish to the RICR website.

B. Click on the “Add>>” button under “Add a Public Comment Period.”

C. The Date of Public Notice will automatically be set to the date you generate the notice. Click on the text box below “Date of End of Comment Period” and select a valid date for the end of comment period. The application will automatically calculate 30 days from the date you generate the notice.

D. Enter the name of the person designated to receive comments for this filing in the “Full Name of Contact Person” text box.

E. Enter the email address of that individual in the “Contact Person Email” text box.

F. Enter the physical address where you would like the public to direct comments.

G. Click on the appropriate radio button to indicate whether you will be accepting online submission of public comments under “Allow online public comments?”
1. If you select “Yes,” you will then need to indicate the dates during which you will accept comments through the RICR. These dates will automatically be pre-set to match the public comment period you indicated in your notice.

2. If you select “No,” you are still required to accept public comments outside of the RICR.

H. Click “OK.”

I. If you will be having a Public Hearing, complete these additional steps:

1. In the text box to the right of the first “Add >>” button, click on the dates for the public comment period you just entered.

2. Click on the “Add >>” button under the “Add a Public Hearing” section.

3. Click the text box under “Hearing date/time.” The application will automatically calculate all available dates ten days after the beginning of your comment period and five days before the end of that comment period. Select a hearing date.

4. Click the dropdown box next to “Time:” and select a time and “AM” or “PM.”

5. Enter text into the fields under “Hearing Location:” marked “Address Line 1”, “City” and “Zip code.”

6. Enter the phone number for the Special Assistance contact in the “Phone Number for Special Assistance” text box. You are not required to enter an extension, but you may.

7. Click on “OK.”

J. Click on the blue “Generate Notice” button at the bottom of the screen.

K. You will now be able to review the public notice you just created before publishing your rule. Review your notice. If you approve, click “Publish.” If you wish to make changes, press “Cancel” to return to the previous screen.

L. You will receive confirmation and a list of documents now available on the public-facing RICR application.

1.4.3 Post Public Comment Period Data update and Document Upload

A. Under the “Work Queue” tab at the top of the screen, expand the Title>Chapter>Subchapter to view your proposed amendment. If you opted to accept public comments through the RICR during the public comment period,
click the icon to review submitted public comments. You must review all public comments before advancing the workflow to the next step. For tips on reviewing public comments, see §1.7 of this Manual.

B. Click on Upload Documents next to the proposed amendment that has completed the public comment period. Download the .doc or .docx version of the proposed rule last uploaded by Department of State staff. Use this version to accept the proposed changes and make additional edits to the rule. This will facilitate a more efficient review at the final step of the rulemaking process.

C. Click the drop-down menu under “Document Type:” and select “Final Rule” from the drop-down menu.

D. Click on “Choose File” or “Browse” (depending on your browser) and select the final, clean Word document for the proposed amendment (final text of the rule, no underlined or struck-through text) and click on the blue “Upload Document” button. (Required)

E. Click the blue “Upload More Documents” button and under “Document Type” select “Public Comment” from the drop-down menu.

F. Click “Choose File” or “Browse” (depending on your browser) and select the document containing a copy of all comments received – or a statement that no comments were received - and click on the blue “Upload Document” button. You may upload additional Public Comment documents, if needed. (Required)

1. You do not need to upload copies of any comments received through the RICR as the application will file those on your behalf.

2. If you considered any comments received inappropriate for public display, those comments should still be kept with the rulemaking file transferred to the Department of State. If the comment was received through the RICR, this process is complete. If the comment was received outside of the RICR, you will need to submit a copy of the comment by email to Administrative Records staff by emailing rulesregs@sos.ri.gov.

G. Click the blue “Upload More Documents” button and under “Document Type” select “Concise Explanatory Statement” from the drop-down menu.

H. Click “Choose File” or “Browse” (depending on your browser) and select your concise explanatory statement. Click “Upload Document.” A template for this document can be found at § 1.15, Appendix 5. (Required)

I. If necessary, click the blue “Upload More Documents” button and under “Document Type” select the appropriate document type(s) from the drop-down menu:
1. Internal Agency Document (See R.I. Gen. Laws § 42-35-2.3(b)(9))

2. Public Hearing Documents (See R.I. Gen. Laws § 42-35-2.3(b)(5))

3. Studies/Reports (See R.I. Gen. Laws § 42-35-2.3(b)(3))

4. Index of Studies/Reports (See R.I. Gen. Laws § 42-35-2.3(b)(3))

5. Petition seeking agency action for this rule (See R.I. Gen. Laws § 42-35-2.3(B)(8))

J. Click the blue “Home” button.

K. To submit for review by the Department of State (DOS): In the “Work Queue” tab, click on the icon next to the title of the rule you just proposed to amend to Advance Workflow. On the following page, click the green “Advance” button.

L. A notification will appear regarding the Office of Regulatory Reform’s review of this filing. If you have received ORR approval, click “Yes.”

M. Provide any necessary notes for Department of State staff in text fields for “Outcome Note” and “Request Note.”

1. Note: If this rule should become effective any later than the typical 20 days after filing, please leave a note for the Department of State in the “Request Note” field with the date you would like this regulation to be effective.

N. Click the blue “Submit” button at the bottom of the screen.

O. Click “OK”. Your submission will be forwarded to the Department of State for formatting review. Please note the Department of State may take up to 5 business days to review and advance or reject your filing.

1.4.4 Agency Head Signature Applied

A. Once the Department of State completes the format review and advances the workflow, an email notification will be sent to the designated Agency Head from eSignLive requesting his or her e-signature. The message will state, “The APA System has added you as a Signer to the eSignPackage “XXX-RICR-XX-XX-XX Title of Regulation”.

B. Once the Agency Head clicks the blue “Go to Documents” button in the eSignLive notification email, he or she will be directed to the secure e-signature site. The Agency Head must accept eSignLive’s consent and disclosures before clicking the marked box to affix his or her digital signature.

C. eSignLive will securely forward the digitally signed document to Department of State staff for final processing. Once the document is fully signed and processed,
the Agency Head will receive email confirmation that the e-signing process has
been completed.

1. The full e-signature procedures are laid out in the Guide for Agency
Heads, a copy of which is included at § 1.18, Appendix 9.

1.5 Repeal Procedures

1.5.1 Initial Data Entry and Documents Upload:

A. Go the RICR application login page at: https://rules.sos.ri.gov/login and provide
your login credentials.

B. Make sure you have the “Current Rules” tab opened at the top of the screen.
Click on: “+ [Title Name]” to expand listing to show all available Chapters.

C. Click on “+ [Chapter Name]” to expand listing to show all available Subchapters.

D. Click on “+ [Subchapter Name]” to expand listing to show all available Parts.

E. Click on the icon next to the Part you wish to repeal.

F. Click on the radio button to select “Proposed” for the Rulemaking Action.

G. Click on the appropriate radio button for the “Rulemaking Process: *”. Either
select “Regular” or “Direct Final”.

H. If you wish to change or amend the rulemaking authority for this Part, select
either “R.I. General Laws” or "Alternative" as the selection in the drop-down
menu in “Rulemaking Authority: *” and enter the appropriate citation in the empty
text box and then click on the blue “Add >>” button. You may do this action as
many times as necessary to list all the applicable statutory authorities for your
repeal.

1. When "R.I. General Laws" is selected, you only need to put in the actual
numbers of the citation (ex. 42-35-1). The application will build the rest of
the citation for you.

I. The summary of proposed rule will be pre-populated from the last rulemaking
action for this Part in the “Summary of Proposed Rule: *” field. You may alter this
text as needed.

J. Provide a brief paragraph regarding the societal cost and benefits and cost of
compliance as prepared under R.I. Gen. Laws § 42-35-2.9. Include any citations
to scientific or statistical studies, reports, or analyses that served as a basis for
the proposed rule in the “Regulatory Analysis Summary and Supporting
Documentation: "" field by typing or by cutting and pasting from an existing document.

K. Enter the web address for the location on your website where the notice of proposed rulemaking and summary of the regulatory analysis are published in the “Additional Information URL: "" field.

L. Click the blue “Submit” button at the bottom of the page.

M. Click the blue “Upload Documents” button.

N. Select “Proposed Rule” from the “Document Type” drop-down menu.

O. Click on “Choose File” or “Browse” button (depending on your browser) and select the Word document containing the proposed rule with proposed deletions using strikethrough formatting.

P. Click the blue “Upload Document” button. You can continue to upload additional documents, if you wish, by clicking "Upload More Documents."

Q. Click the blue “Home” button.

R. You can now review the proposed rule you uploaded under the "Text" tab on the right side of the screen. You can use this feature to check your work.

S. To submit for review by the Department of State (DOS): Under the “Work Queue” tab, click on the icon next to the title of the rule you just proposed to repeal to Advance Workflow. On the next page, click the green “Advance” button.

T. A notification will appear regarding the Office of Regulatory Reform’s review of this filing. If you have received ORR approval, click “Yes.”

U. Provide any necessary notes for Department of State staff in the text fields for “Outcome Note” and “Request Note” (optional).

V. Click the blue “Submit” button at the bottom of the screen.

W. Click “OK”. Your submission will be forwarded to the Department of State for formatting review. Please note the Department of State may take up to 5 business days to review and advance or reject your filing.

1.5.2 Generation of the Notice of Proposed Rulemaking & Submission for Promulgation

A. Under the “Work Queue” tab at the top of the screen, expand the

Title>Chapter>Subchapter to view your proposed repeal and click on the
icon to generate the Notice of Proposed Rulemaking and publish to the RICR website.

B. Click on the “Add>>” button under “Add a Public Comment Period.”

C. The Date of Public Notice will automatically be set to the date you generate the notice. Click on the text box below “Date of End of Comment Period” and select a valid date for the end of comment period. The application will automatically calculate 30 days from the date you generate the notice.

D. Enter the name of the person designated to receive comments for this filing in the “Full Name of Contact Person” text box.

E. Enter the email address of that individual in the “Contact Person Email” text box.

F. Enter the physical address where you would like the public to direct comments.

G. Click on the appropriate radio button to indicate whether you will be accepting online submission of public comments under “Allow online public comments?”

1. If you select “Yes,” you will then need to indicate the dates during which you will accept comments through the RICR. These dates will automatically be pre-set to match the public comment period you indicated in your notice.

2. If you select “No,” you are still required to accept public comments outside of the RICR.

H. Click “OK.”

I. If you will be having a Public Hearing, complete these additional steps:

1. In the text box to the right of the first “Add >>” button, click on the dates for the public comment period you just entered.

2. Click on the “Add >>” button under the “Add a Public Hearing” section.

3. Click the text box under “Hearing date/time.” The application will automatically calculate all available dates ten days after the beginning of your comment period and five days before the end of that comment period. Select a hearing date.

4. Click the dropdown box next to “Time:” and select a time and “AM” or “PM.”

5. Enter text into the fields under “Hearing Location:” marked “Address Line 1”, “City” and “Zip code.”
6. Enter the phone number for the Special Assistance contact in the “Phone Number for Special Assistance” text box. You are not required to enter an extension, but you may.

7. Click on “OK.”

J. Click on the blue “Generate Notice” button at the bottom of the screen.

K. You will now be able to review the public notice you just created before publishing your rule. Review your notice. If you approve, click “Publish.” If you wish to make changes, press “Cancel” to return to the previous screen.

L. You will receive confirmation and a list of documents now available on the public-facing RICR application.

1.5.3 Post Public Comment Period Data update and Document Upload

A. Under the “My Actions” tab at the top of the screen, expand the Title>Chapter>Subchapter to view your proposed repeal. If you opted to accept public comments through the RICR during the public comment period, click the icon to review submitted public comments. You must review all public comments before advancing the workflow to the next step. For tips on reviewing public comments, see § 1.7 of this Manual.

B. Click on Upload Documents next to the proposed repeal that has completed the public comment period.

C. Click the drop-down menu under “Document Type:” and select “Final Rule” from the drop-down menu. This document should be the same document you uploaded at the proposed stage, showing all language struck through.

D. Click on “Choose File” or “Browse” (depending on your browser) and select the repeal Word document (the rule showing all text struck-through) and click on the blue “Upload Document” button. (Required)

E. Click the blue “Upload More Documents” button and under “Document Type” select “Public Comment” from the drop-down menu.

F. Click “Choose File” or "Browse" (depending on your browser) and select the document containing a copy of all comments received – or a statement that no comments were received - and click on the blue “Upload Document” button. You may upload additional Public Comment documents, if needed. (Required)

1. You do not need to upload copies of any comments received through the RICR as the application will file those on your behalf.
2. If you considered any comments received inappropriate for public display, those comments should still be kept with the rulemaking file transferred to the Department of State. If the comment was received through the RICR, this process is complete. If the comment was received outside of the RICR, you will need to submit a copy of the comment by email to Administrative Records staff by emailing rulesregs@sos.ri.gov.

G. Click the blue “Upload More Documents” button and under “Document Type” select “Concise Explanatory Statement” from the drop-down menu.

H. Click “Choose File” or “Browse” (depending on your browser) and select your concise explanatory statement. Click “Upload Document.” A template for this document can be found at § 1.15, Appendix 5. (Required)

I. If necessary, click the blue “Upload More Documents” button and under “Document Type” select the appropriate document type(s) from the drop-down menu:

1. Internal Agency Document (See R.I. Gen. Laws § 42-35-2.3(b)(9))
2. Public Hearing Documents (See R.I. Gen. Laws § 42-35-2.3(b)(5))
3. Studies/Reports (See R.I. Gen. Laws § 42-35-2.3(b)(3))
4. Index of Studies/Reports (See R.I. Gen. Laws § 42-35-2.3(b)(3))
5. Petition seeking agency action for this rule (See R.I. Gen. Laws § 42-35-2.3(B)(8))

J. Click the blue “Home” button

K. To submit for review by the Department of State (DOS): In the “Work Queue” tab, click on the icon next to the title of the rule you just proposed to repeal to Advance Workflow. On the following page, click the green “Advance” button.

L. A notification will appear regarding the Office of Regulatory Reform’s review of this filing. This applies only to regular rulemaking. If you have received ORR approval, click “Yes.”

M. Provide any necessary notes for Department of State staff in text fields for “Outcome Note” and “Request Note.”

1. Note: If this rule should become effective any later than the typical 20 days after filing, please leave a note for the Department of State in the “Request Note” field with the date you would like this regulation to be effective.

N. Click the blue “Submit” button at the bottom of the screen.
O. Click “OK”. Your submission will be forwarded to the Department of State for formatting review. Please note the Department of State may take up to 5 business days to review and advance or reject your filing.

1.5.4 Agency Head Signature Applied

A. Once the Department of State completes the format review and advances the workflow, an email notification will be sent to the designated Agency Head from eSignLive requesting his or her e-signature. The message will state, “The APA System has added you as a Signer to the eSignPackage “XXX-RICR-XX-XX-XX Title of Regulation”.

B. Once the Agency Head clicks the blue “Go to Documents” button in the eSignLive notification email, he or she will be directed to the secure e-signature site. The Agency Head must accept eSignLive’s consent and disclosures before clicking the marked box to affix his or her digital signature.

C. eSignLive will securely forward the digitally signed document to Department of State staff for final processing. Once the document is fully signed and processed, the Agency Head will receive email confirmation that the e-signing process has been completed.

1. The full e-signature procedures are laid out in the Guide for Agency Heads, a copy of which is included as § 1.18, Appendix 9.

1.6 Emergency Rule Procedures (§ 42-35-2.10)

A. If an agency determines that an emergency rule (§ 42-35-2.10) is required due to a finding of imminent peril, they may file an emergency rule without Notice of Proposed Rulemaking, Public Comment or a Public Hearing.

1. The rule will go into effect when it has been signed by the Agency Head and the Governor or Governor’s designee.

2. The rule will remain in effect for a maximum of 120 days.

3. An emergency rule should contain mark-ups to denote deletions and additions to the existing rule and be accompanied by a statement of the agency’s finding of imminent peril which requires the emergency rule.

4. The agency may renew the emergency rule once for an additional sixty (60) days.

5. The actions and approvals steps for an emergency rule are as follows:
   a. Initial Data Entry and Documents Upload
   b. Rules Coordinator Notification of Emergency Rule
c. Submission for Promulgation

d. Agency Head Signature Applied

e. Governor Signature Applied

f. Final Rule and Signature acceptance by DOS

g. Promulgation Finalization

h. Submission for Emergency Extension 1

i. DOS Final revision for Emergency Extension 1

j. Finalization of Emergency Extension 1

1.6.1 Initial Data Entry and Documents Upload, Rules Coordinator Notification and Submission for Promulgation:

A. Go the RICR application login page at: https://rules.sos.ri.gov/login and provide your login credentials.

B. Click on “+ [Title Name]” to expand listing to show all available Chapters.

C. Click on “+ [Chapter Name]” to expand listing to show all available Subchapters.

D. Click on “+ [Subchapter Name]” to expand listing to show all available Parts.

E. Click on next to the Part to start the emergency amendment process (for an emergency adoption, click the blue “New Adoption” button; for an emergency repeal, click on ).

F. Click on the radio button to select “Emergency” for the Rulemaking Action.

G. Review the Statutory Authority already populated in the right-hand box and click the “<<Remove” button if the information is not accurate.

H. If further or new Statutory Authority information is required, select either “R.I. General Laws” or “Alternative” as the selection in the drop-down menu in “Rulemaking Authority: *” and enter the appropriate citation in the empty text box and then click on the blue “Add >>” button. You may do this action as many times as necessary to list all the applicable statutory authorities for your filing.

I. Remove the text from the previous rulemaking completed for this Part, if applicable, and, in plain language, provide a statement of the subject matter of the proposed rule, including the terms or substance of the intended action, or a description of the issues involved. Include a summary of any non-technical changes between current and proposed regulations in the “Summary of
Proposed Rule: **” field by typing or by cutting and pasting from an existing document.

J. Provide your finding for imminent peril to the public health, safety, or welfare or the loss of federal funding in the “Brief Statement of Reason for Finding Imminent Peril: **” field by typing or by cutting and pasting from an existing document.

K. Enter the URL address for the emergency rule and reasons for finding of imminent peril published on your agency website in the “Additional Information URL: **” field.

L. Click the blue “Submit” button at the bottom of the page.

M. Click on “Upload Documents” blue button.

N. Select “Proposed Rule” from the “Document Type” drop-down menu.

O. Click on “Choose File” and select the Word document containing the proposed amendment with the emergency language clearly marked using underline formatting for emergency insertions, and strikethrough formatting for emergency deletions.

P. Click on the blue “Upload Document” button.

Q. Click the blue “Home” button.

R. Under the “Work Queue” tab at the top of the screen, the Title>Chapter>Subchapter will be expanded allowing you to view your emergency rule and click on the icon to advance the workflow.

1. Note: this advancement sends a notification to the Rules Coordinator that an emergency rule has been entered. At this point, the rule has NOT been sent to the agency head for signature. This is to ensure an agency is afforded the opportunity to complete any internal procedures prior to obtaining the Agency Head’s e-signature.

S. Again, under the “Work Queue” tab, expand the Title>Chapter>Subchapter to view your emergency rule and click on the icon to advance the workflow.

T. A notification will appear regarding the Office of Regulatory Reform’s review of this filing. If you have received ORR approval, click “Yes.”

U. Click the blue “Submit” button at the bottom of the screen.

V. Click “OK”.

1.6.2 Agency Head & Governor Signatures Applied
A. Once the workflow has been advanced, an email notification will be sent to the designated Agency Head from eSignLive requesting his or her e-signature. The message will state, “The APA System has added you as a Signer to the eSignPackage “XXX-RICR-XX-XX-XX Title of Regulation”.

B. Once the Agency Head clicks the blue “Go to Documents” button in the eSignLive notification email, he or she will be directed to the secure e-signature site. The Agency Head must accept eSignLive’s consent and disclosures before clicking the marked box to affix his or her digital signature.

C. eSignLive will securely forward the digitally signed document to the Governor’s Office for his or her electronic signature. The Governor or Governor’s designee will indicate his or her name and click the indicated signature box to affix his or her digital signature.

D. eSignLive will securely forward the digitally signed document to Department of State staff for final processing. Once the document is fully signed and processed, the Agency Head and Governor’s Office will receive email confirmation that the e-signing process has been completed. The agency Rules Coordinator will receive notification that the filing has been completed.

1. The full e-signature procedures are laid out in the Guide for Agency Heads, a copy of which is included as § 1.18, Appendix 9.

1.6.3 Submission for Emergency Extension

A. In the “Current Rules” tab, scroll down to the expandable Title>Chapter>Subchapter listing beneath the heading “Active Emergency Rules.”

B. Click the 🏥 icon next to the emergency rule you wish to renew.

C. Click the green Advance button.

D. (Optional) Enter any Outcome Notes or Request Notes you wish to keep with the rulemaking record. Click

E. Click the blue “Submit” button on the bottom of the screen. The extension request will be submitted and the effective date of this emergency filing will be extended an additional 60 days.

1.7 Reviewing Public Comments

A. If you opted to allow members of the public to submit comments directly through the RICR, you must complete a review process for each comment submitted before you can advance a regulation for finalization.
B. Under the “Work Queue” tab at the top of the screen, expand the Title>Chapter>Subchapter to view the proposed adoption, repeal or amendment. Click the icon to review submitted public comments. Please note you may review comments during the public comment period.

C. All comments submitted through the RICR will be listed in the “Pending” tab for those not yet reviewed and in the “Reviewed” tab for those already reviewed.

1. When you are ready to forward your regulation to the Department of State for final review, make there are no comments remaining in the “Pending” tab.

D. For each comment received, click anywhere on the underlined text of that comment to expand the details. Click the “Review” button.

E. Determine whether the agency considers the comment appropriate for public display. If yes, click the radio button for “Yes” next to “Enable public comment display?” If no, click the radio button for “No”.

1. If you indicate that the comment is not appropriate for public display, you must provide the reason that comment should not be displayed. To give a reason other than the ones provided, select “Other” and enter text in the box below the drop-down menu.

2. All comments are marked or . You may re-review comments in the “Reviewed” tab at any time before advancing the regulation to the next step in the workflow.

F. If you wish, you may enter internal review notes – which will not be visible to the public – and/or public review notes – which are optionally displayed to the public.

G. Click the blue “OK” button.

H. To print a report of comments for dissemination to staff, click the blue “Print” button at the top of the page. This report is produced on-demand. You may perform this action as many times as you wish.

1.8 Technical Revision Procedures (§ 42-35-4(b))

A. A minor non-substantive change can be made through a written request (via email) from an agency’s Rules Coordinator or initiated by Administrative Records Office staff. If initiated by Administrative Records Office staff, the agency Rules Coordinator will be notified of the change. The scope of these corrections can run from grammar, punctuation, and cross-reference corrections, to a name change of the agency.
B. If you would like the Administrative Records Office to complete a technical revision on a regulation, please contact us at rulesregs@sos.ri.gov.

1.9 Termination Procedures

A. You may choose to terminate a filing at any time by clicking the icon next to the name of that Part in your Work Queue and indicating a reason for termination.

B. If the Part you wish to terminate is not in your Work Queue but is under review by the Department of State or your Agency Head, you may recall that Part to your Work Queue by clicking “Reset” next to the name of the Part in the “Under Review” tab. You may then terminate the Part by following the instructions above.

C. When terminating a Part which was filed as an adoption but did not complete the rulemaking process, even if it never advanced to the public comment stage, you will not be able to use that Part number again in the future.

1.10 Requirements under the APA

1.10.1 Rulemaking Agenda Procedures (§ 42-35-5.1)

A. The rulemaking agenda is a document listing all proposed rulemaking currently in effect for your agency. The rulemaking agenda must be updated in real time and include the following information for all rules proposed by your agency:

1. The subject matter of the proposed rule;
2. Notices related to the proposed rule;
3. How comments on the proposed rule may be submitted;
4. The time within which comments may be submitted;
5. Where comments may be inspected;
6. Requests for a public hearing;
7. Appropriate information concerning a public hearing, if any; and
8. The timetable for action on the proposed rule.

B. The law requires that the rulemaking agenda be published both on the agency’s website and the Department of State’s website.
The rulemaking agendas will be published in the RICR application under the Agency Summary. The Department also has APIs available to allow agencies to pull this information directly from the RICR onto their respective websites.

1.10.2 Guidance Document Index Procedures (§ 42-35-2.12)

A. Agency Rules Coordinators must submit a Guidance Document Index to the Department of State annually. This does not preclude an agency from updating its Index throughout the year as new documents are published. The Index must also be published on the agency’s website.

B. The APA defines a Guidance Document as: “a record of general applicability developed by an agency which lacks the force of law but states the agency’s current approach to, or interpretation of, law or describes how and when the agency will exercise discretionary functions.” (§ 42-35-1(9))

C. The Guidance Document Index should contain the title, publication date, and URL of any guidance documents published by the agency.

D. Submission of Guidance Document Index:

1. Go the RICR application login page at: https://rules.sos.ri.gov/login and provide your login credentials.

2. Click on the Manage drop-down menu at the top of the screen and select "Guidance Index."

3. Click on "New" at the upper right-hand side of the screen.

4. Any guidance documents you previously entered will appear in the Guidance Document List. You can now add or remove guidance documents to create a new Index.

   a. To remove documents from the list, highlight the document name and click the blue “Remove” button.

   b. To add documents to the list, enter the publication date of your guidance document, the title of your guidance document, and the URL where the guidance document is published on your website (Note: if you do not include “http:// or https:// in your document link, no hyperlink will be created). Click the “Add” button. Repeat as needed.

5. When all current guidance documents are entered, click the "Generate Guidance Document Index" button at the bottom of the page.

E. Please note if your agency does not have any guidance documents, you are still required to submit a Guidance Document Index annually. To do so, follow the
steps above. Do not enter any guidance document information. Click “Generate Guidance Document Index.” A blank index will be created stating that your agency does not have any guidance documents.

F. Once you generate your Index, you can download a copy to manually post on your website or link directly to the Index on the RICR.

1.10.3 Declaratory Orders and Declaratory Order Index Procedures (§ 42-35-8)

A. If an agency issues a declaratory order, the order must contain the names of all parties to the proceeding, its factual basis, and the reasons for the agency’s conclusion.

B. The Declaratory Order becomes effective once filed electronically with the Department of State.

C. An agency must publish a current index of all effective declaratory orders.

D. When you file a declaratory order in the RICR application, the Declaratory Order Index is automatically updated.

E. Filing of Declaratory Order in the RICR application:

   1. Go the RICR application login page at: https://rules.sos.ri.gov/login and provide your login credentials.

   2. Click on the Manage drop-down menu at the top of the screen and select "Declaratory Order".

   3. Click on "New" at the upper right-hand side of the screen.

   4. Enter the title of the Declaratory Order in the "Document Title" text field.

   5. Click on "Choose File" or "Browse" depending on your browser and select the Declaratory Order for upload and click "Upload Document".

   6. The document you uploaded will now be available for review under the heading “Declaratory Orders Awaiting Submission.” Confirm you have uploaded the correct document. If you have, click “Approve” to forward the Declaratory Order to Department of State staff for filing.

   7. Once the Department of State processes the document, it will be added automatically to the agency’s Declaratory Order Index.

1.10.4 Advance Notice of Proposed Rulemaking Procedures (ANPRM) (§ 42-35-2.5)

A. An Advance Notice of Proposed Rulemaking is not a required step in the rulemaking process; however, it is a useful tool if an agency wishes to gather
information and solicit comments and recommendations from the public prior to posting a proposed rule.

B. The agency must publish a copy of the ANPRM on its website.

C. The meeting must be open to the public and is subject to the Open Meetings Act, R.I. Gen. Laws Chapter 42-46.

D. Procedures for filing of an ANPRM in the RICR application:

1. Go the RICR application login page at: https://rules.sos.ri.gov/login and provide your login credentials.

2. Click on “+ [Title Name]” to expand listing to show all available Chapters.

3. Click on “+ [Chapter Name]” to expand listing to show all available Subchapters.

4. Click on “+ [Subchapter Name]” to expand listing to show all available Parts.

5. Click on the radio button to select “Advance Notice” for the Rulemaking Action.

6. For a possible adoption: assign a new Part number in the Rule Identifier: * text box.

7. Enter the title of the potential Part that is the subject of the ANPRM in the Regulation Title: * text box.

8. Enter the Statutory Authority citation(s) or review the Statutory Authority already populated in the right-hand box and click the “<<Remove” button if the information is not accurate. If further or new Statutory Authority information is required, select either “R.I. General Laws” or "Alternative" in the drop-down menu next to “Rulemaking Authority:”* and enter the appropriate citation in the empty text box. Click on the blue “Add >>” button. You may do this as many times as necessary to list all of the applicable statutory authorities for your adoption or amendment.

9. Provide the Advance Notice Details indicating where, when, and how persons may comment before the rulemaking process begins.

10. Enter the URL address for the ANPRM published on your agency website in the “Additional Information URL:”* field.
12. Click the blue “Submit” button at the bottom of the page.

13. If you are attaching a proposed rule: click “Upload Documents”.
   a. Select “Proposed Rule” from the “Document Type” drop-down menu.
   b. Click on “Choose File” and select the Word document containing the proposed rule with the proposed language clearly marked using underline formatting for proposed insertions and strikethrough formatting for proposed deletions.
   c. Click on the blue “Upload Document” button.
   d. Click “Home” to return to the Work Queue. Click on the icon next to the title of your ANPRM to advance the workflow. Click the green Advance button to publish your ANPRM and related rule document.

14. If you do not want to upload a document, click on.

15. Enter any outcome or request notes (optional), then click Submit. Click Ok.

16. Under the “Work Queue” tab, click the icon to generate the Advance Notice of Proposed Rulemaking and publish to the RICR website.

17. Click on the “Add>>” button under “Add a Public Comment Period.”

18. The Date of Public Notice will automatically be set to the date you generate the notice. Click on the text box below “Date of End of Comment Period” and select a valid date for the end of comment period. There are no restrictions on the length of the comment period for an Advance Notice.

19. Enter the name of the person designated to receive comments for this filing in the “Full Name of Contact Person” text box.

20. Enter the email address of that individual in the “Contact Person Email” text box.

21. Enter the physical address where you would like the public to direct comments.

22. Click on the appropriate radio button to indicate whether you will be accepting online submission of public comments under “Allow online public comments?”
a. If you select “Yes,” you will then indicate the dates during which you will accept comments through the RICR. These dates will automatically be pre-set to match the public comment period you indicated in your notice.

b. If you select “No,” you will still accept public comments outside of the RICR.

23. Click “OK.”

24. If you will be having a Public Hearing, complete these additional steps:

   a. In the text box to the right of the first “Add >>” button, click on the dates for the public comment period you just entered.

   b. Click on the “Add >>” button under the “Add a Public Hearing” section.

   c. Click the text box under “Hearing date/time.” The application will automatically calculate all available dates within the public comment period you selected. Select a hearing date.

   d. Click the dropdown box next to “Time:” and select a time and “AM” or “PM.”

   e. Enter text into the fields under “Hearing Location:” marked “Address Line 1”, “City” and “Zip code.”

   f. Enter the phone number for the Special Assistance contact in the “Phone Number for Special Assistance” text box. You are not required to enter an extension, but you may.

   g. Click on “OK.”

25. Click on the blue “Generate Notice” button at the bottom of the screen.

26. You will now be able to review the Advance Notice you just created before publishing it. If you approve, click “Publish.” If you wish to make changes, press “Cancel” to return to the previous screen.

27. You will receive confirmation and a list of documents now available on the public-facing RICR application.

E. At any time during or after the public comment period you set for your Advance Notice, you may choose to continue on to the full rulemaking process. To do this, click the icon next to the name of your ANPRM in the “Work Queue” tab. You can then follow the steps outlined in the sections above.
1.10.5 Petition for Promulgation of Rules (§ 42-35-6)

A. Each agency must promulgate a rule providing an explanation of the procedure for an individual to petition the agency to promulgate a rule.

B. The rule must contain the following information:
   1. the form of the petition;
   2. the procedure for submitting the petition to the agency; and
   3. the procedure the agency must follow in considering and acting on the petition.

C. The Department of State has provided a sample Petition for Promulgation of Rules regulation (Appendix 6: Sample Petition for Promulgation of Rules Regulation). This sample is intended as a tool for agencies’ use in promulgating its rule as required by the APA. Agencies are not required to use the sample when promulgating their regulation regarding Petition for Promulgation of Rules.

1.10.6 Petition for Declaratory Order (§ 42-35-8)

A. Each agency must promulgate a rule providing an explanation of the procedure for an individual to petition the agency for a declaratory order.

B. The rule must contain the following information:
   1. the form of the petition;
   2. the procedure for submitting the petition to the agency; and
   3. the procedure the agency must following in considering and acting on of the petition.

C. The Department of State has provided a sample Petition for Declaratory Order regulation (Appendix 7: Sample Petition for Declaratory Order Regulation). This sample is intended as a tool for agencies’ use in promulgating its rule as required by the APA. Agencies are not required to use the sample when promulgating their Petition for Promulgation of Rules.

1.10.7 Conduct of Public Hearings (§ 42-35-2)

A. Each agency must promulgate a rule prescribing the way public hearings are conducted.

B. The Department of State has provided a sample Conduct of Public Hearings regulation (Appendix 8: Conduct of Public Hearings Regulation). This sample is intended as a tool for agencies’ use in promulgating its rule as required by the
APA. Agencies are not required to use the sample when promulgating their Conduct of Public Hearings regulation.
1.11 Appendix 1: Examples of Styles in the RICR Template

REPLACE THIS TEXT WITH THE FULL RICR NUMBER (XX-RICR-XX-XX-XX)

REPLACE THIS TEXT WITH THE RICR TITLE NUMBER – NAME (AGENCY NAME)

REPLACE THIS TEXT WITH THE RICR CHAPTER NUMBER – NAME (FUNCTION)

REPLACE THIS TEXT WITH THE RICR SUBCHAPTER NUMBER - NAME (TOPIC)

REPLACE THIS TEXT WITH THE RICR PART NUMBER – NAME (REGULATION)

[The suggested numbering and format below will help you create your new regulation. Replace each ‘x’ with the appropriate number for both rule numbers and statute citations - Delete this paragraph and any other extraneous text below.]

x.1 Replace This Text with a Heading (Title 1)

x.1.1 Replace This Text with a Subheading (Title 2 – this heading level is optional)

A. Replace this text with Paragraph 1 – use the following subsections as appropriate

1. Replace this text with Paragraph 2 (subsection of Paragraph 1)

   a. Replace this text with Paragraph 3 (subsection of Paragraph 2)

      (1) Replace this text with Paragraph 4 (subsection of Paragraph 3)
1.12 Appendix 2: Regular Rulemaking Process


Public Comment period begins (minimum of 30 days) → Agency gives Notice of Proposed Rulemaking → Agency submits proposed rule to Dept. of State for format review

Agency holds public hearing (optional) at least 10 days after notice and at least 5 days before end of comment period → Public comment period ends → Agency finalizes rule

Rule goes into effect twenty (20) days after filing with the Dept. of State → Agency submits final rule to Dept. of State for review and files rule → Submit finalized rule to OMB
1.13 Appendix 3: Direct Final Rulemaking Process

Agency decides to commence rulemaking on a rule it deems non-controversial

Completes regulatory preparation and submits to OMB for review


Notice of Proposed Rulemaking of Direct Final Adoption, Amendment or Repeal

Rule becomes effective as of the end of public comment period

No objection received: Agency files final rule and rulemaking documents in the RICR Filing Application

Public comment period ends

Objection received: Agency must start rulemaking process again using the steps outlined in Appendix 2
1.14 Appendix 4: Emergency Rulemaking Process

Agency finds imminent peril which requires immediate filing of emergency rule

Submits to OMB for review

Agency head and Governor (or designee) sign rule

Agency publishes rule and finding of imminent peril on their website

Agency files emergency rule with Dept. of State

Rule in effect for 120 days

Emergency rule may be renewed once, for 60 days. *(Must be filed within the 120 emergency period.)*

Rule expires and previous rule comes back into effect, if applicable

New rule that has completed the APA promulgation process is adopted addressing the imminent peril
CONCISE EXPLANATORY STATEMENT

In accordance with the Administrative Procedures Act, R.I. Gen. Laws § 42-35-2.6, following is a concise explanatory statement:

AGENCY:

DIVISION: *(If any)*

RULE IDENTIFIER: *(RICR Citation)*

RULE TITLE: Provide the full title of the rule.

REASON FOR RULEMAKING: Provide a brief description of the reason for the adoption, amendment or repeal of the rule.

ANY FINDING REQUIRED BY LAW AS A PREREQUISITE TO THE EFFECTIVENESS OF THE RULE: *(if any)*

TESTIMONY AND COMMENTS: Provide the reasons for not accepting arguments made in testimony and comments.

CHANGE TO TEXT OF THE RULE: Identify any changes between the text of the rule as proposed and the text of the final rule and explain why these changes were made to the final text. Note that an agency may not file a rule that differs from the rule proposed in the notice of proposed rulemaking unless the final rule is consistent with, and a logical outgrowth of, the rule proposed in the notice.

REGULATORY ANALYSIS: Provide the text of the regulatory analysis prepared under § 42-35-2.9.
Appendix 6: Sample Petition for Promulgation of Rules Regulation

This sample is an example only and not intended to be prescriptive of an agency’s requirements under the Administrative Procedures Act. Agencies may choose to disregard this sample.

XXX-RICR-XX-XX-XX

RICR TITLE NUMBER - NAME (AGENCY NAME)

RICR CHAPTER NUMBER - NAME (FUNCTION)

RICR SUBCHAPTER NUMBER - NAME (TOPIC)

THE RICR PART NUMBER - Petition for Promulgation of Rules

x.1 Purpose

The purpose of this regulation is to prescribe the form of a Petition for Promulgation of Rules pursuant to R.I. Gen. Laws § 42-35-6 and the procedure for its submission, consideration, and disposition.

x.2 Authority

This regulation is promulgated pursuant to the authority granted in R.I. Gen. Laws § 42-35-6.

x.3 Definitions

A. The following definitions shall apply to this regulation:

1. "Department" means <insert agency>.

2. "Petition" means a request for the Promulgation of a Rule.

3. "Petitioner" means a person requesting the promulgation of a rule.

4. "Promulgate", with respect to a Rule, means the process of writing a new Rule, or amending or repealing an existing Rule.

5. "Rule" means the whole or a part of an agency statement of general applicability that implements, interprets, or prescribes law or policy or the organization, procedure, or practice requirements of an agency and has the force of law. The term includes the amendment or repeal of an existing rule. The term is used interchangeably with the term "regulation." The term does not include the exceptions listed in R.I. Gen. Laws §§ 42-35-1(19)(i) through (vi).
x.4  **Request for the Promulgation of a Rule**

A. A request to Promulgate a Rule must be in writing and include the following information:

1. The name and address of the Petitioner;

2. A plain statement identifying the rule or proposed new Rule at issue;

3. A detailed statement of all facts relied upon by the Petitioner;

4. A plain statement requesting the Promulgation of a Rule, and further indicating whether Petitioner seeks a new Rule or the amendment or repeal of an existing Rule.

   a. In the case of a request for the repeal of an existing Rule, the Petitioner shall identify the Rule by title and/or RICR citation.

   b. In the case of a request for an amendment to an existing Rule, the Petitioner must identify with specificity any proposed additions, deletions, or other amendments. New proposed language must be clearly marked using underline formatting for proposed insertions, and strikethrough formatting for proposed deletions.

B. A request for the Promulgation of a Rule must be submitted to:

<Insert agency contact information.>

x.5  **Consideration and Disposition of Request for the Promulgation of a Rule**

A. The Department shall promptly consider and respond to the request for the Promulgation of a Rule as provided in R.I. Gen. Laws § 42-35-6.

B. The Department may, at its discretion and within the thirty (30) day period prescribed by statute:

1. Hold a hearing for further consideration and discussion on the Petition; or

2. Request further information or documents from the Petitioner necessary for the full evaluation of his or her Petition.
1.17 Appendix 7: Sample Petition for Declaratory Order Regulation

This sample is an example only and not intended to be prescriptive of an agency’s requirements under the Administrative Procedures Act. Agencies may choose to disregard this sample.

XXX-RICR-XX-XX-XX

RICR TITLE NUMBER – NAME (AGENCY NAME)

RICR CHAPTER NUMBER – NAME (FUNCTION)

RICR SUBCHAPTER NUMBER - NAME (TOPIC)

RICR PART NUMBER – Declaratory Order Petitions

x.1 Purpose

This regulation states the requirements for submitting a request for Declaratory Order under R.I. Gen. Laws § 42-35-8(b), and the procedure for its consideration and prompt disposition.

x.2 Authority

This regulation is promulgated pursuant to the authority granted in R.I. Gen. Laws § 42-35-8.

x.3 Definitions

A. The following definitions shall apply to this regulation:

1. "Declaratory Order" means an order issued by the Department that:
   a. Interprets or applies a statute administered by the Department;
   b. Clarifies whether a rule, guidance document, or order issued by the Department applies to a Petitioner; or
   c. Clarifies how a rule, guidance document, or order issued by the Department applies to a Petitioner.

2. "Department" means <insert agency>.

3. "Petition" means a request for a Declaratory Order.

4. "Petitioner" means a person requesting a Declaratory Order.
x.4 Request for Declaratory Order: Form and Submission

A. A request for Declaratory Order must be in writing and include the following information:

1. The name and address of the Petitioner;
2. A plain statement identifying the statute, rule, guidance document, or order at issue;
3. A detailed statement of all facts relied upon by the Petitioner;
4. A copy of any and all documents relied upon by Petitioner that are not otherwise accessible to the Department; and
5. A plain statement requesting a Declaratory Order, and further indicating whether Petitioner seeks:
   a. An interpretation or application of a statute administered by the Department;
   b. Clarification as to whether a rule, guidance document, or order issued by the Department applies to Petitioner; and/or
   c. Clarification as to how a rule, guidance document, or order issued by the Department applies to Petitioner.

B. A request for a Declaratory Order must be submitted to: <insert agency contact information.>

x.5 Consideration and Disposition of Request for Declaratory Order

A. The Department shall promptly consider and respond to the request for Declaratory Order as provided in R.I. Gen. Laws § 42-35-8(c).

1. Should the Department schedule the matter for further consideration, the Department shall notify Petitioner in writing of the anticipated date on which the Department will grant or deny the request for Declaratory Order.

B. The agency may, at its discretion:

1. Hold a hearing for further consideration and discussion on the Petition; or
2. Request further information or documents from the Petitioner necessary for the full evaluation of his or her petition.

C. A Petitioner may appeal the Department's final disposition of the request for Declaratory Order as provided in R.I. Gen. Laws § 42-35-15.
1.18 Appendix 8: Sample Conduct of Public Hearings Regulation

This sample is an example only and not intended to be prescriptive of an agency’s requirements under the Administrative Procedures Act. Agencies may choose to disregard this sample.

XXX-RICR-XX-XX-XX

RICR TITLE NUMBER - NAME (AGENCY NAME)

RICR CHAPTER NUMBER - NAME (FUNCTION)

RICR SUBCHAPTER NUMBER - NAME (TOPIC)

RICR PART NUMBER - Conduct of Public Hearings

x.1 Purpose

To establish a defined set of procedures for the <insert agency> for the conduct of Public Hearings regarding Proposed Rulemaking.

x.2 Authority

This regulation is promulgated pursuant to the authority granted in R.I. Gen. Laws § 42-35-2(a)(4).

x.3 Definitions

A. For the Purpose of this regulation:

1. "Department" means <insert agency>.

2. “Member of the Public” means any individual, firm, business, corporation, association, partnership or other group.

3. “Presiding Department Official” means the <insert agency> employee conducting the Public Hearing.

4. "Public Hearing" means the convening of Members of the Public and agency personnel for the purpose of obtaining public comment on a Proposed Rulemaking.

5. “Proposed Rulemaking” means a proposed new rule, proposed amendment to a rule or proposed repeal of a rule as noticed pursuant to R.I. Gen. Laws § 42-35-2.7.
Procedure for Conduct of Public Hearings

A. Convening of Public Hearing
   1. Public Hearings may be held at the election of the agency or as required pursuant to R.I. Gen. Laws § 42-35-2.8(c).
   2. Notice of Public Hearings shall be issued in accordance with the provisions of R.I. Gen. Laws §§ 42-35-2.8 and 42-46-6, when applicable.
   3. The Public Hearing shall be held at a time and place designated by the Department.

B. Transcription
   1. The Public Hearing shall be transcribed by a stenographer or audio recorded.
   2. For Public Hearings, any official transcript, recording, or memorandum summarizing presentations prepared by an agency official shall be made part of the rulemaking record in accordance with R.I. Gen. Laws § 42-35-2.3(b)(5).

C. Testimony
   1. Oral Testimony
      a. Members of the public may make oral testimony during the meeting.
      b. Members of the public who wish to make oral testimony during the meeting must put their name on the speaker list.
      c. Members of the public will be called to testify in the order which their names appear on the speaker list.
   2. Written Testimony
      a. Written testimony must be submitted via e-mail, fax, hand delivery or regular mail to: <insert contact information>.

D. Disruptive Conduct
   1. Members of the Public attending the Public Hearing shall not cause disruptions, including but not limited to: screaming, loud noises, and disorderly gesticulations, which interrupt or distract from the testimony of other Members of the Public or from the ability of the Presiding Department Official to conduct the Public Hearing.
Overview of the Rhode Island Code of Regulations and E-Signatures

A. The Rhode Island Code of Regulations (RICR) is a uniform, online code of all regulations promulgated by state agencies, boards and commissions according to the state’s Administrative Procedures Act (APA), R.I. Gen. Laws Chapter 42-35. Regulations filed in the RICR are assigned a unique identifying number and must adhere to formatting standards set by the Department of State.

B. Any regulation published in the RICR after August 14, 2018, requires a digital signature by the head of the agency promulgating that regulation. This includes regular, direct final, and emergency adoptions, amendments and repeals. This procedure does not apply to Technical Revisions which are processed entirely by Department of State staff.

1. Note: The APA defines “Agency Head” as “the individual in whom, or one or more members of the body of individuals in which, the ultimate legal authority of an agency is vested” (R.I. Gen. Laws 42-35-1).

C. The Department of State contracts with eSignLive, a third-party e-signature vendor, to apply digital signatures to regulations published in the RICR. A secure copy of each signed regulation is then immediately archived by Department of State staff in a trusted digital repository where it undergoes constant surveillance to ensure the lasting integrity of these important public records.

Getting Started

A. The filing application allows, but does not require, an Agency Head to perform a number of functions to move a proposed regulation through the rulemaking process. Keep in mind the Agency Head is never required to log in to the RICR application.

B. When you are first assigned the role of Agency Head in the RICR application, you will receive an email from rulesregs@sos.ri.gov asking you to agree to receive notifications through the RICR. You need only accept this request once.

C. If you would like a member of your staff to receive duplicate copies of notifications sent to you through the RICR, please follow the procedures below.

1. Log in to the RICR filing application using your unique credentials.

2. Select “Notifications” under the “Manage” menu at the top of the screen.
3. A list of all users with login credentials for your agency will appear. Click the “Subscribe” button next to any user you wish to receive the same notifications you do. That user will then receive an email requesting acceptance of this subscription.

4. Once a user is subscribed, the button next to that user’s name will read “Unsubscribe.” You may follow the same steps to unsubscribe him or her at any time.

**Applying Your Signature**

A. When a member of your staff submits a final regulation for your signature, you will receive an email notification directly from eSignLive. The email will include a link to the document requiring your signature.

B. Click the button labeled “Go to Documents.” Your default browser will open and eSignLive will load the regulation awaiting your approval. The first page you see will be eSignLive’s “eSign Disclosures and Consent.” For your convenience, a copy of this disclosure is included below at § 1.4, Appendix 1. Once you have reviewed the document, scroll to the bottom and click the button marked “Accept.” Note: if you do not perform this action, you will not be able to apply a digital signature to your regulation.

C. The full text of the final regulation awaiting your signature will appear. Scroll to the last page of the document to find the signature page. All fields will be blank and a digital sticky note will be placed in the area you must click to apply your digital signature.

1. At this stage, you may download and/or print this document, if you wish.
D. Once you have clicked the appropriate box, you will be asked to confirm by clicking “Ok.” The date and time you performed this action will automatically be recorded and entered in the text field box to the right of your signature. A pop-up confirmation will appear. Click “Exit.”

E. No further action is required. The signed copy of your regulation will be securely forwarded to Department of State staff who will indicate the regulation’s effective date and complete the filing.

1. In the case of an emergency adoption, amendment or repeal, the signed copy of your regulation will be securely forwarded to the Governor’s Office. Once the Governor or Governor’s designee has applied his or her signature, the regulation will again be securely forwarded to Department of State staff who will complete the filing process.

F. You will receive an email directly from eSignLive indicating that the signing process is completed for this regulation. This email will include a link; however, because the document you signed has already been securely removed from eSignLive and transferred to a digital archives, that link will not direct you to a copy of the fully signed regulation. Should you click that link, you will receive the following error message:
G. If you would like to review the completed filing, a copy will immediately be published to the RICR and available for review and download.

**eSign Disclosures and Consent**

A. Below is a copy of the “eSign Disclosures and Consent” issued by eSignLive. In order to access and digitally sign a regulation, you must accept these terms.

---

**ESIGN DISCLOSURES AND CONSENT**

It is required by law to provide you with certain disclosures and information about the products, services or accounts you may receive or access in connection with your relationship with us (‘Required Information’). With your consent, we can deliver Required Information to you by a) displaying or delivering the Required Information electronically; and b) requesting that you print or download the Required Information and retain it for your records.

This notice contains important information that you are entitled to receive before you consent to electronic delivery of Required Information. Your consent also permits the general use of electronic records and electronic signatures in connection with the Required Information.

After you have read this information, if you agree to receive Required Information from us electronically, and if you agree to the general use of electronic records and electronic signatures in connection with our relationship, please click the ‘ACCEPT’ button below.

**Statement of electronic disclosures:**

You may request to receive Required Information on paper, but if you do not consent to electronic delivery of Required Information, we cannot proceed with the acceptance and processing to create a relationship with you in connection to the products, services or account.

If you consent to electronic delivery of Required Information, you may withdraw that consent at any time. However, if you withdraw your consent we will not be able to continue processing to create a relationship with you in connection to the products, services or account.

If you consent to electronic disclosures, that consent applies to all Required Information we give you or receive from you in connection with our relationship and the associated notices, disclosures, and other documents.

You agree to print out or download Required Information when we advise you to do so and keep it for your records. If you are unable to print or download any Required Information, you may call us and request paper copies. If you need to update your e-mail address or other...
contact information with us, you may do so by calling us and requesting the necessary updates.

If you wish to withdraw your consent to electronic disclosures, you may do so by calling us and requesting withdrawal of consent. After consenting to receive and deliver Required Information electronically, you may request a paper copy of the Required Information by calling us.

If you do not have the required software and/or hardware, or if you do not wish to use electronic records and signatures for any other reason, you can request paper copies of the Required Information to be sent to you by calling us.

Your consent does not mean that we must provide the Required Information electronically. We may, at our option, deliver Required Information on paper. We may also require that certain communications from you be delivered to us on paper at a specified address.

I have read the information about the use of electronic records, disclosures, notices, and e-mail, and consent to the use of electronic records for the delivery of Required Information in connection with our relationship. I have been able to view this information using my computer and software. I have an account with an internet service provider, and I am able to send e-mail and receive e-mail with hyperlinks to websites and attached files. I also consent to the use of electronic records and electronic signatures in place of written documents and handwritten signatures.